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INTERVIEW PEDIA 

                                APTITUDE TEST 

  

 

                                                          

PART- 11 

In the Last issue we have started a new area called ‘Critical Reasoning’. Here 
is its continuation…………….. 

For example, if this is a “Find the Assumption” question, I know that an 
assumption is something that the author of the argument must believe to be true in 
order to draw that conclusion.  

(Note: I might disagree; I might think that assumption doesn’t have to be 
true.)  

The assumption is something the argument’s author must believe and the 
argument’s author must believe that piece of info specifically in order to get from 
one of the argument’s premises to the argument’s conclusion. So, now I know that I 
need something the author must believe to be true specifically in order to tie 
together one of the premises with the conclusion; that answers questions 1 and 2, 
above. 

Right answers on Find the Assumption questions will often be closely tied to 
the conclusion. They will not make the conclusion definitely true, but they may 
make the conclusion seem more valid or, at the least, it may be easier to understand 
why the author believes the conclusion is more valid. Right answers must bridge 
some gap between one of the given premises and the conclusion; it isn’t enough just 
to address the conclusion.  

 

 

 

 

 Finally, if the right answer is negated (if we say that assumption is not true or 
doesn’t have to be true), then the author’s conclusion should make a lot less sense. 

 



The trickiest wrong answers will often address just a premise or just the 
conclusion, without bridging a gap between a premise and the conclusion. Wrong 
answers also may “follow on” from the conclusion, or talk about what would 
happen after the conclusion is accepted as valid.  

As always, some wrong answers may simply be out of scope, addressing 
something that isn’t the point of the argument. If the wrong answer is negated (if 
we say the assumption is not true or doesn’t have to be true), the author’s 
conclusion shouldn’t be affected much. 

Major Take-Aways 

On all Critical Reasoning questions: 

(1) Read the question stem first. Identify the question type. If additional 
information is present, use it to help you find / know the conclusion as quickly 
and easily as possible. 

(2) Quickly remind yourself. Once you’ve identified the question type, quickly 
remind yourself of what you need to do on questions of this type. (If you’ve done 
the necessary studying, this should only take a few seconds.) 

(3) Anticipate. If there are certain traps you tend to fall into on questions of this 
type, know why you tend to make those mistakes and set up a process to help you 
avoid them. 

How to approach critical reasoning questions? 

1. Read the argument carefully. Wherever possible, identify premises, 

assumptions and conclusion.  

(Take approx. 30 seconds to understand.) 

2. Take a few extra seconds to make sure you understand the conclusion of the 

argument. 

3. Read the question prompt to find what you are asked to do (strengthen / 

weaken / find assumption etc.) and then think what a correct answer might 

involve.  

(Take approx. 30 seconds to think.) 

4. Now read the answer choices. Select the best answer ½ this should be easy if 

you have not rushed the previous steps.  

(Take approx. 30 seconds to read and select.) 

Analyze the information on which each question is based, and then choose the 
most appropriate of the answer choices. In the next issue we are going to 
travel into Watson Glaser critical thinking test, which is the most popular 
CR area. 
 
  Meet you all in the next issue………….All the best! 

                    Staff-Editor 

 



        

  

 The mirror looks like a computer display but it is also a mirror since you can see 

yourself in it. At top of the screen, a clock and a real-time weather hub are perched at the 

top of the screen and the app icons can be dragged and moved anywhere on the screen, 

pretty much like how one would do on an iPhone or an iPad. The apps, however, don’t 

open in full screen and that probably has something to do with the scaling restrictions. 

The apps open up in smaller windows and the user can toggle the settings by using your 

mirror as a touch screen, this also means that you can use selected apps on the mirror 

itself. 

 

 Apple company newly invented the apple mirror which is a smart touch screen 

mirror based on Apple’s iOS 10. It includes the time and date in the upper right-hand 

corner and weather in the top left. All apps can be moved around and placed anywhere 

on the mirror. 

 This mirror is able to text, play songs, movie, browse the internet and even you can 

order an UBER ride. This mirror is getting prominent in market by the other name called 

as Apple Mirror. 

 The mirror shuts itself off after 45 seconds of inactivity and shows reflection like a 

regular mirror.  A touch or tap on anywhere in the mirror screen makes the icons appear.  

  

 



 The icons are neatly arranged on the left and right side of the mirror. Drag and Drop 

options enable the possibility of arranging the icons in the apple mirror and the possibility 

of re-arranging them anywhere on the screen. Now standing in front of mirror and 

analyzing your physique will be more intense and interesting as you can now get yourself 

ready in a very unique way.  

 

 This mirror supports all the functions of iOS 10 like texting, video call, using 

camera recording your own video, playing apple games on your touch screen mirror. This 

can tap anywhere to wake back up and resume use. Some useful things you can do with 

this mirror. Request an Uber, watch Netflix, read the news, control smart thermostat / 

light bulbs, control Sonos speaker system and more. The smart mirror looks like a gigantic 

full sized  iPhone with intuitive details like the time, weather forecast widget and icons 

with full-fledged apps.  

 He takes us through the apps, swiping and household control functions, which mean 

that the mirror serves as a one-stop life admin tool. Its external look just resembles a 

mirror doing its work perfectly reflecting the things around it. What is extraordinary about 

the mirror is that along with reflecting an image, it can also be used as a smart phone. 

 

 

 

 



 

 

 

 Enabling access to banking is a pre-requisite to promote cashless economy. So 

the success of initiatives such as Jan Dhan accounts linked to Aadhaar data will be 

very important. A robust payments mechanism to settle a digital transaction is also 

needed, though the National Electronic Funds Transfer and Real Time Gross 

Settlement services. The Indian central bank will also have to shed some of its 

conservatism, part of which is because it has often seen itself as the protector of 

banking interests rather than overall financial development.  

 

 

 

    The expansion of telecom and smart phones would provide a digital shift to the 

economy in near future. The private sector the driver of this change. Government 

is also mulling to provide incentives for electronic payments for example waiver of 

tax when electronic settlements are used. The private sector has to come forward to 

drive the change. Apart from this government should also give incentives for 

electronic transactions.  

 

  

   The cashless economy has its own advantages. The transaction   costs are coming 

down and will further go down. Once a substantial part of transactions are cashless, 

it would bring down the cost of printing, managing and moving money around.  



   Further, the cashless economy automatically solves the problems of cash out on 

long holidays, risk of carrying currency notes etc. Further, the lesser use of cash 

strangulates the grey economy, prevents money laundering and increase tax 

compliance. Increased tax base would result in greater revenue for state and greater 

amount available to fund the welfare programmes. Lastly, Cash being material, can 

be prevented from circulation but electronic channels alleviate this friction and 

increase circulation of currency. 

    

 

Unified Payment Interface (UPI):  

*App-based transaction platform on smartphones. 

*Download the UPI app, create your unique ID, and set your PIN. 

*Send/receive funds using this unique ID. 

 

E-Wallet:  

*Another app-based payment mechanism. 

*Link debit or credit card and use the app for payments. 

*Top up the e-wallet with cash and use for transaction. 

Cards:  

*Payments can be made using prepaid, debit or credit card.  
*Needs a PoS terminal to swipe the card. 

 

 

 

 

 

 

 

 

 

 

Aadhaar-enabled payment system:  

*Link your Aadhaar card with bank account.  

*Transfer funds or withdraw cash using Aadhaar number and biometric 

authentication. 

 

Unstructured Supplementary Service Data (USSD):  

*Normal mobile phone used to transfer funds.  

*Mobile number linked to bank. 

 

 



 

 

 Over the years DJI has pushed out four generations of the wondrous Phantom. It 

is been very similar to the IPHONE. Each time it becomes sleeker, the camera 

quality slightly improves, and a few new minor features get thrown in.     Pilots 

have been patiently waiting for autonomous flying and more advanced crash 

prevention. This time, DJI answered the call.  

 

Autonomous Flight: The camera is just as amazing as the Phantom 3. Can 

shoot 4K video and take 12MP still shots from the mobile device or tablet. This 

time they designed a new gimbal to allow for smoother video. Active Track and 

Tap Fly. 

Active Track: The Phantom 4, will now be able to track an object both following 

and filming. Traditional image tracking only utilizes two-dimensional tracking data. 

Once the camera changes direction the system will confuse itself and lose sight of 

whatever it is tracking. DJI’s Phantom 4 uses different technology. It can essentially 

build a 3D representation of the object, learning the object looks like from various 

angles. It’s constantly learning what the object looks like. For instance, if sit or take 

a breather from running, the drone will relearn doing to continue focusing on your 

following movements. 

Tap Fly: Almost all other drones out there rely on a GPS chip placed in the 

controller to follow. With the Phantom 4 you can tell it where to go with the tap of 

finger. Tap on a point and the aircraft will fly in the direction of the point avoiding 

objects in the way. Tap Fly will give the ability to capture smooth video shots 

without even touching the controller. If you decide to change directions it will 

gracefully transition paths. It will also avoid all objects in its path.  



Crash Prevention: The Phantom 4 had cameras installed in the front, 

preventing from running into objects in the way. Kidding aside, this feature was 

much needed. Hopefully it will prevent from sending it in for a repair. There are 

also downward facing cameras and sonar sensors on the bottom of the aircraft. This 

allows the drone to rely on the Visual Positioning System rather than completely 

relying on GPS. 

 

 

Light and Stable: The Phantom 4 is smaller than the younger generations, 

giving it long battery life and becoming more portable. A lot of people claim the 

battery lasts longer than the advertised 28 minutes. The Phantom 4 also comes with 

an additional internal measurement unit (IMU) which makes it much more stable in 

flight. This beast on propellers was also given upgraded motors. When in sport 

mode you can do a number of amazing things. Can reach speeds of 45 miles per 

hour. Be careful when flying in sport mode because once you turn it on object 

avoidance goes out the window. 

New Features 

 Overall design 

 Gimbals design 

 Flight time – 28 min (5 min more) 

 Speed – 45 mph (10 mph faster) 

 Obstacle avoidance sensors 

 Signal range – 3 miles 

 4K Ultra HD 

 Tap Fly 

 

 

 

 



 

 

 

 And every year Facebook CEO Mark Zuckerberg the sixth-richest person in the 

world with a net worth of $44.6 billion takes a personal challenge to learn new 

things and grow this knowledge. And in 2016 Mark announced to build a simple AI 

to run home and with work, also said that it won't look like what we seen in iron 

man movie.   

 On Facebook page, Zuckerberg posted that to give a voice like Jarvis in iron man 

movie, to home AI.  Zuckerberg’s AI is capable of controlling the house, including 

connected lights and thermostat. It was developed with help from Facebook 

engineers and uses voice recognition along with face recognition software. So it can 

do things like open the gate to the house without needing to receive a specific 

command first, the AI can open the gate automatically by scanning owners face and 

not by entering some secret code. 

 The Facebook founder also admitted that Zuckerberg is the only one who can 

control the AI for now. Not even his wife, Priscilla Chan, is able to use it. And gives 

a visualize data in VR that helps to build better service and lead an organization 

more effectively.  

 It’s still unclear exactly what Zuckerberg plans to do with the AI once it’s finished. 

What started as a personal challenge could end becoming the company’s answer to 

the Amazon Echo, Google Home and whatever competing smart home hub apple 

is working on. 



  Google home is another home AI which is a finished project by Google. It comes 

with a few hardware and speaker which is connected to internet, it can turn on/off 

lights, controls music system and almost everything which is digital can be 

controlled by it. 

 The questions to Google home is, whether it will search it in Google database and 

answers it excitingly in a few moments. Google home is now available for sale.  We 

may also buy it to set up an AI in home system. Google Home can retrieve flight 

information, set alarms and timers, and even tells about the traffic on our way to 

work. 

 

 AIML, IPL, SMALLTALK, PROLOG, LISP, etc., are some of the commonly 

used programming language to build artificial intelligence. IPL was the first 

language developed for artificial intelligence. It includes features intended to 

support programs that could perform general problem solving techniques. 

 To become an efficient AI developer, they must be a good programmer and 

mathematician, should know many programming languages and a lot of experience 

to do it. 

 Before a few years back AI is just an imagination in science fiction movies but 

now it is real and helps human to work more effectively, and to solve problems in 

day to day life. 

 

 



 

 

 

 SanDisk Connect Wireless Stick can be accessed wirelessly to stream media or 

transfer large files, and save and share photos and videos to and from your mobile 

device. The SanDisk Connect app installed on your mobile device, you can upload, 

download, save, share and play all your stuff from a distance, to and from the device 

you want to use. Share your pictures or favourite music with friends and family to 

up to 3 devices simultaneously. The app can also automatically backup device’s 

data such as photos and videos to the drive when the drive is connected.  

 The app is available for both Android and iOS, and setup a password to protect 

your wireless connection. SanDisk Wireless Connect Stick can connect to 

computers and mobile devices for wireless management and streaming of media. It 

also lets you manage the stored content via the SanDisk Connect app, in addition to 

supporting content sharing on large displays. The stick works with both Android 

and IOS devices, and lets you stream videos to up to 3 devices at a time. 

 

 

Design: 

 There's only so much can do when it comes to designing a USB stick, so there's 

not much to say about the design of SanDisk Connect. It comes in two dual-

coloured variants -- one is black and bronze, while the other one is white and silver. 

Our review unit was the white and silver one. Wireless Connect isn't really that big 

either, measuring almost the same as a regular USB dongle. The front of the stick 

is textured and bears the SanDisk branding at the bottom. A power button is placed 

on the right edge of the wireless stick. The top has a transparent cap that can be 

detached when the stick is in use. In essence, SanDisk Connect Wireless Stick has 

a simple yet functional design. 

 

 



 

 

Connecting to the Connect Wireless Stick: 

 The Connect Wireless Stick will work with IOS and Android devices via an app, 

a PC and Mac with a full-size USB port or over a web browser for USB-C devices 

like Apple's new Mac Book and the Google Chrome book Pixel. For mobile 

devices, you'll need to download the SanDisk app from the App Store or Google 

Play Store. After the app, has been downloaded, power on the drive by pressing the 

side-mounted power button on the Connect Wireless Stick, ensure that the drive 

isn't plugged into your computer's USB port and connect mobile device to the 

drive's wireless network by going into phone’s Wi-Fi settings. 

 

 

Performance:  

 SanDiskConnect wireless stick supports both IOS and Android, and can connect 

to smart phones via the dedicated SanDisk Connect Drive app. Also, connect the 

stick to laptops and PCs via Wi-Fi. If have an IPhone 6S or IPhone 6S Plus, can 

directly save the Live Photos on the wireless stick. The stick works like any other 

flash drive, but also comes equipped with wireless capability. However, it has to be 

charged regularly as well. During our testing, we were able to connect our 

smartphones via the app without facing any problems. We even tried connecting it 

to various devices at once and as claimed by the company, the stick connected to 

up to three devices at once, with no problems at all. The stick can also be used for 

streaming media to other devices over Wi-Fi. However, one downside found was 

that the Connect Wireless stick couldn't connect via mobile data, only Wi-Fi. 

 

 

 

http://www.techradar.com/news/computing-components/storage/sandisk-increases-macbook-storage-with-usb-c-external-ssd-1295411
http://www.techradar.com/reviews/pc-mac/laptops-portable-pcs/laptops-and-netbooks/new-macbook-2015-1287806/review
http://timesofindia.indiatimes.com/tech/more-gadgets/SanDisk-launches-Connect-Wireless-Stick-mobile-flash-drive-in-India/articleshow/48916007.cms


 

 

 

 I Ring is a new invention of apple company such as its other innovative devices 

and products like I Phone which is one of the most successful smart phones in the 

world now they released a new concept. I Ring which is a stylish, useful and modern 

ring design that could suit any gender’s hand easily, it is produced in two main 

colours black and white. 

 Using this ring iPod fans can take control of their music player easier, not just for 

iPod btw, this ring is mend to control all Apple’s Product. Take a look at its stylish 

design and wireless Bluetooth connectivity with your iPod and I Phone, the I Ring 

allows us to control playback and volume on any of our Apple media devices.  

 

 

  

 I Ring feature a bright OLED status display with a touch-sensitive function strip, 

and a rechargeable battery life of up to 2 days. Connect recharge to Ring using the 

included cradle. Its minimal size and unique ring-lock mechanism make it an ideal 

companion for charging and storing your I Ring.  

 The designer’s name is Victor Soto. This is just one of his concepts hope it will 

soon become a product. 

 

 

 

 



  

 The I Ring was simply a concept that was imagined for the sole purpose of 

controlling an iPod, which is one of the reasons that it is sometimes called the iPod 

Ring.  

 

 

 

 

 

 

 

 

 

 

 

 

 The I Ring is actually the predecessor to the Bluetooth ORB. This ring would be 

programmed to act as a remote control for the TV, meaning that wearers would not 

need a remote.  

 When used with GPS the device allows to authorize mobile payments by simply 

making a checkmark-like gesture, or signing one’s name in mid-air.   

  This would reduce clutter and make control a little easier, but does sound more 

than a little farfetched as the ring would be more useful for outdoors, and anyone 

going out, then inside of the home. So far rumours vary but the I Ring should be 

able to: 

 Control volume 

 Change song 

 Alert to calls 

 Control TV 

 Act as a motion sensor. 

 

 

 

 

 



  

 Android 7.0–7.1.1 "Nougat" is the seventh major version of the Android operating 

system. First released as a beta build on March 9, 2016, it was officially released 

on August 22, 2016 with Nexus devices being the first to receive the update, though 

the LG V20 was the first new Smartphone released with Nougat.  

 Nougat introduces notable changes to the operating system and its development 

platform, including the ability to display multiple apps on-screen at once in a split-

screen view, support for inline replies to notifications, as well as an Open JDK-

based Java environment and support for the Vulkan graphics rendering API, and 

"seamless" system updates on supported devices. 

 

 

  On March 9, 2016, ahead of the Google I/O developer conference, Google 

released the first beta of Android "N" as part of a new "Android Beta Program" 

intended for testing by developers and enthusiasts before official release "this 

summer". The developer preview builds were compatible with only current Google 

Nexus devices; the 5X, 6P, 6, 9, Pixel C, and Nexus Player.  

 The "Android Beta Program" that was introduced allows testers to opt-in for over-

the-air updates to new beta versions as they are released. Android 7.1 was pre-

loaded onto Google's Pixel and Pixel XL smartphones released in October 2016. 

  

 

 

 



 The new version included background installation of system updates, as well as 

support for the Google Daydream VR platform, and additional app functionalities. 

 Google announced and released Android 7.1.1 on December 5, 2016. The update 

included new emoji, specifically emojis related to gender equality; GIF support in 

Google Allo, Google Messenger and Google Hangouts; and app shortcuts directly 

on the phone's home screen. 

     

 

 Nougat introduces a system for enabling "seamless", automatic system updates, 

based upon and sharing some code with the implementation of similar functionality 

on Chrome OS. The system uses a pair of SquashFS partitions; the Android system 

executes from an "online" partition, while updates are applied in the background to 

a redundant "offline" partition. On the next boot following the installation of an 

update, the redundant partition is designated as active, and the device henceforth 

boots into the updated system. 

 The previous system partition is kept as a backup in case of update failure, and to 

serve as the "offline" partition for the next update. This system removes the 

requirement for the device to reboot into the system recovery environment to apply 

the update (which prevents the device from being used until the update is complete) 

and also provides the ability for an update to be automatically rolled back in case 

of a failure. Due to the partitioning requirements of this system, existing devices 

will not support seamless updates. 

 

 

 

 

 

 



  

   

 

 

  The new tune makes its holiday season debut courtesy of a team of 

computer scientists in the Department of Computer Science at the University of 

Toronto. The researchers fed 100 hours of pop songs to a type of artificial 

intelligence  (AI) known as a recurrent neural network, which learns and performs 

by building connections between input data, much like the human brain does. 

 

The researchers then tested the ability to generate a song about an image — 

a decorated Christmas tree surrounded by wrapped presents — using a process 

called "neural story singing," which they described in a study currently under 

review for a conference presentation. [Super-Intelligent Machines: 7 Robotic 

Futures] 
 

 

To write the song, the researchers first had the computer produce a story 

about the festive image. Then, selected a rhythm of one beat per word, linked the 

endings of sentences to the endings of the music's bars, and tuned it so that the 

vocals would occur in a "natural" pitch range, the scientists said. The neural 

network then took the song to completion. 

 

 



 

Its efforts did, in fact, produce something that resembles a Christmas song 

— there are references to Christmas trees, presents, and "lots and lots and lots of 

flowers." But the vocals are disturbingly dirge-like and the lyrics include perplexing 

non sequiturs such as, "A hundred and a half hour ago / I'm glad to meet you." 

 

 
 

AI song writing recently grabbed the spotlight when a team of scientists at 

Sony CSL Research Lab shared a Beatles-style song called "Daddy's Car," whose 

melody and parts of the orchestration were created by a computer system called 

Flow Machines.  

The authors of the new study admitted that more work needs to be done for 

AI-generated melodies and lyrics to more closely mimic those penned by humans. 

Their Christmas song may offer some listeners a welcome break from the time-

honoured classics. 

 

 

 

 



  

 

 

 

 An animated GIF, an image file that allows us to feature animated images that 

makes it seem like the image is moving. Think of them as a hybrid between a still 

image and a video. 

Step 1: Upload any images to Photoshop.  

      To upload them into Photoshop, click File > Scripts > Load Files Into Stack. 

           Then, select Browse and choose which files you'd like to use in the GIF, 

then click OK. Create each frame of the animated GIF as a different Photoshop 

layer. To add a new layer, choose Layer > New > Layer. 

Step 2: Open up the Timeline window. 

  

To open Timeline, go to the top navigation, choose Window > Timeline.  

Step 3: In the Timeline window, click "Create Frame Animation." 

Step 4: Create a new layer for each new frame. 

To do this, first select all the layers by going to the top navigation menu and 

choosing Select > All Layers. 

 

 

 

From the dropdown menu that appears, choose Create new layer for each new 

frame. 

 



Step 5: Open the same menu icon on the right, and choose "Make Frames From 

Layers." 

Step 6: Under each frame, select how long it should appear for before switching 

to the next frame. 

Step 7: At the bottom of the toolbar, select how many times you'd like it to loop. 

Step 8: Preview the GIF by pressing the play icon. 

Step 9: Save the GIF to use online. 

     

 

  Save it to use online by going to the top navigation bar and clicking File > 

Export > Save for Web (Legacy). 

 Next, choose the type of GIF file you'd like to save it as under the Preset 

dropdown. If you have a GIF with gradients, choose Dithered GIFs to prevent 

color banding. If an image employs a lot of solid colors, then opt for no dither.  

 Click Save at the bottom to save the file to the computer.  Now its ready to 

upload this GIF to use in any marketing! 

 Upload the GIF file into any place online that put an image, and it should play 

seamlessly. 

 

 

 

 

 

 



 

 

PAYROLL SOFTWARE 

 Payroll software is technology that aims to streamline and automate the 
process of paying a company's employees. Payroll software can be purchased 
from a human resources technology vendor or included as a module within a 
larger Enterprise Resource Planning (ERP) package.    

    

 

ASG Payroll Software Benefits: 

 Consolidated entry screen for fast, efficient payroll entries.  

 Prints complete W2 and 1099 forms immediately upon install.  

 Supports unlimited number of employees. 

 Supports unlimited deductions, and enables you to easily manage payroll 

benefits like cafeteria plans, vacation time, 401ks and many more.  

 When used in conjunction with the Accounts Payable module, can 

automatically generate tax liability invoices.  

 Effective and Start Date for Payroll features such as benefits, vacation and 

401k.  

 The only major payroll processing product in the marketplace which 

supports encrypted Social Security Numbers at the database level. 

 Supports paper check runs, EFT electronic direct deposits or both.  

 

 



 

ASG Payroll Features:  

 Multiple bank account capability. 

 Social Security number encryption. 

 Detailed posting to General Ledger. 

 Posting by transaction or check date. 

 Customized data fields. 

 Easily process multiple checks per employee and multiple pay frequencies. 

 Supports all 50 states including DC, Virgin Islands and Puerto Rico. 

           

 

 Choose either quick payroll entry or traditional. 

 Multiple check copies. 

 Direct payroll deposit. 

 W2 and 1099 printing. 

 Unlimited earnings and benefits types. 

 Fixed Departmentalization. 

 Variable Departmentalization - ability to allocate or departmentalize based 

on actual number of hours (or dollars) in a specific pay period. 

 

 



 

 

 

Linus Torvalds 
(Founder of Linux OS) 

BORN ON & IN DECEMBER 28,1969-49(Helsinki, 
Finland) 

EDUCATION University of Helsinki(1988-1996) 

FAMOUS AS Software Engineer 

BOOK BY LINUS JUST FOR FUN(2001) 

EMPLOYER LINUX FOUNDATION 

KNOWN For LINUX KERNAL, LINUX, GIT, SUBSURFACE 

ALSO KNOWN AS Linus Benedict Torvalds 

AWARDS 1998 - EFF Pioneer Award,2005 - Vollum 

Award  

2006 - 2000 Award for Industry 

Achievement 

His famous                             
works 

 Points out the crap in os x 

 Responds to bug reports and 

names git 

 Disparages security people 

 Linus touts a new release of Linux 

 

 



 

 

1. Speak to “tweet” is the service provided by which internet giant? 

2. Who is the father of free software foundation? 

3. Expand SOPA. 

4. What is Spam related to e-mails? 

5. Xoom is the tablet computer introduced by which company? 

6. Which is the tablet computer introduced by Amazon? 

7. Expand CATFOSS. 

8. Who is the current IT minister in India? 

9. WIT is the NASDAQ code of which Indian company? 

10. Who is the prince invested 300 million dollars in Twitter? 

11. What is SIRI? 

12. What version of Windows introduced the Task Bar? 

13. What is F8 related to Facebook? 

14. What is IMPS banking system? 

15. In Trivandrum Techno Park what is T BIC? 

 

 

 



 

 

 

 

 

 

1. I am the end of life but also the start of earth. 

I wait in the middle of the ocean but not there in the bank. 

I stay very close to the beginning of the death. 

I am able to enter in the heaven but also there in the midst of the hell. 

 

What Am I? 

 

2. Which number replaces the question mark? 

 

 

 

3. Can you decipher below rebus?  

 

 

 

 

 

4. A Child was born on Lahore, Pakistan. 

 

  Still child is not a Pakistani citizen. Why? 

https://2.bp.blogspot.com/-QIoIty86wR0/VgwZikqpsKI/AAAAAAAAOic/EJUusnKubaM/s1600/Rebus.gif


5. Can you count the number of triangles in the figure below?  

 

  

 

 

 

6. How will you place six crosses on a Tic TAC TOE board without forming 

any three-in-a-row Combination? 

  

 

 

 

7. What Word is represented by this rebus?  

 

 

 

 

 

8. Can you name the country by deciphering the below rebus?  

 

 

 

9. When were the first recorded olympics held?  

 

10. You need to pick any number from '1, 3, 5, 7, 9, 11, 13 and 15' to make 

below equation true. 

( ) + ( ) + ( ) = 30 

Can you solve it? 
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